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Protocol for setting up SPA data collection using BIS method. 

Before starting make sure that microscope is working correctly.  On the microscope 
computer TEM Imaging Analysis (TIA), Microscope software launcher, FEI-SEM server, and 
Gatan remote TEM are running.  On the Gatan K3 computer make sure digital micrograph 
and SerialEM are running. Check network connections on the Gatan K3 computer. 

This document is for core staff only and researcher that have been trained to use the 
microscope. 

Typical work flow for a single-particle data collection using beam-image 
shift 
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1. On the Gatan K3 computer make a new folder in the X: directory to save your data.  Make 
sure that the X: drive has enough free space if it is full delete old data.  Make sure the 
data has been fully transferred to the longleaf cluster or the NAS before deleting the data. 

Windows File Manager 

 “This PC” → Capture Data (X) → K3Data → [new session file: date_initals] 

       ie 20250502_JDS_CBL 
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At this point you are ready to start the session. 

2. Start the Autoloader Inventory on the microscope computer. 

If the cassette slot is occupied by a cartridge make it blue using the mouse clicker, if empty 
make dark grey.   

Check temperature of the autoloader and column before starting the Inventory. 

Check “Turbo Auto Off” on the Autoloader Option tab (blue arrow) 

 

Click Inventory to start (should take ~15 mins) 

2nd Left 
Mouse Click 
to change 
color (slot 
state) 

1st Click Edit 
Slot State 

Wait for 
autoloader to cool 
to -155  (should be 
green not red) 
before inventory. 

Click inventory 
to start 
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At this point the Autoloader inventory is complete with no errors on the microscope, as 
shown in this image. 

 

Optional do gain reference during the Inventory and direct alignment on evaporated 
aluminum or another TEM grid (not UltrAufoil). 
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3. On SerialEM open the current Setting file for SPA.   

“Settings” → 20250325_SPA_45k” (Yellow arrow) 

Or go to C:\Program Files\SerialEM\ 

Load one of the setting files  

 20250325_SPA_45K (normally use this – pixel size 0.8737 Å) 

 20250427_SPA_73K (Pixel size 0.54925 Å) 

 20250427_SPA_22K (Pixel size 1.7738 Å) 

 

 

Make sure Low-Dose Mode is checked in the Low Dose Control Panel (Blue arrow).   

Check Record, View, Focus, and Search make sure the beam centered and camera 
settings are correct for each.  

To do this first in the microscope alignment tab select Beam shift and use the multi-
function XY knobs on the control panels to center the beam in Record mode. Then select 
“Additional beam shift Set” in the Low-Dose Control panel to move the beam in View, Focus 
and Search” using the multi-function XY knobs (do not select beam shift). 

 
To change the beam setting or magnification ect…Click “continuous update” on the 
Low-dose Control Panel.  Normally you will not need to do this. 
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4. Run the script DoseCal to write to the SerialEM log file what the imaging conditions 
are. 

“Script” → “Edit” → “Script1: DoseCal” 

Navigate to a broken grid square or unload grid (preferred).  Go to microscope computer 
and under the Autoloader tab to unload the cartridge.   

Go to record in low dose make sure the 70 micron condenser aperture is inserted and 
centered.  Make sure the imaging and camera parameters are exactly what you are using to 
collect data. 

Run “DoseCal” → pop-up: navigate to [new session file: date_initals] → “Ok” 

  { It writes CS, Voltate, flux, total dose and pixel size to the log file} 

If needed using a Cross-replica, evaporated aluminum, or carbon coated Quantifoil 
grid align the microscope. 

5. Montage each of the grids in cassette using script Map2Grids. 

Before running script read the header and follow the instructions 
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Read the script header for instructions.  

 

 “Navigator” → “Open” to open the Navigator 

“Script” → “Edit” → “2” (“Script2: Map2Grids”) 

 Edit the script Parameters 

 Edit “SetDirectory X:\k3data\” [new session file: date_initals] 

 Edit “cat”: each cartridge you want to montage 

 Edit “name”  name of file or sample 

 

Go to “Search” in low dose and make sure it is set to 62X with the C2 150 micron 
condenser aperture inserted. 

If Search is a different magnification, change it by checking continuous update in the Low 
Dose Control and set the magnification to 62X.  Alternative select the 62X 4uP in the 
imaging state panel. 

Check the Search beam on the FlueCam on the microscope.  If needed center the beam 
using by checking the “additional beam shift” in low-dose panel and beam-shift using the 
multi-function XY knobs. If needed center the aperture in the Tab Aperture, click Adjust, and 
center using the multifunctional ZY knobs. 
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In SerialEM 

“Navigator” → “Montaging and Grids” → “Setup Full Montage” 

In the pop-up click “Ok” normally you don’t need to change anything.   

If needed, adjust “number of pieces” (default 6 x 10, full stage limit)  

Check camera(K3), Mag (62), Bin (1), Overlap (20%) 

“Save As” → Navigator [new session file: date_initals] → [fullgridmontage] → “Save” 

“Script2: Map2Grids” → Run (takes about 15 minutes per grid). 

 

Alternative you can montage a single grid on the stage, as described above but don’t 
run the script just Click “Start” on Montage Control Panel. 

It will take ~ 15 mins to montage one grid.  

At this point the montaging is done, and the maps are saved in the navigator.    
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6. Collect grid square montages at each grid square you want to collect data at. 

On SerialEM zoom into Full Grid Montage and add point to the center of the grid squares 

Navigator → Add Points → stop adding points → mark points Acquire (A) 

 

Find eucentric height (once at one grid square) using stage Wobbler on the microscope 
computer and “Update Z” for Acquire points (Purple arrow).   
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Change Search to 210 X magnification.  

 Imaging state → select “Square Search SPA” (mag 210)  

Or check continuous update on low-dose panel and change magnification of 
Search.  Uncheck continuous update when done. 

Note for 200 mesh grids you will need to use mag of 115 not 210. 

Check camera parameters in Search. 

 Carmera → Parameters → “square” → “OK” 
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Take an image of the grid square and copy the image to Buffer M and N in the Buffer 
Controls pannel (Yellow Arrow). 

 

Open new montage file 

File → Montage Set up  

Check camera(K3), Mag (210), Bin (1), Overlap (20%), Check move stage instead of 
shifting image, check make map from each montage if navigator is open, check 
close file when montage is done, check use Search parameters in low dose mode. 
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Save As → Navigator (X:\k3data to [new session file: date_initals]  → [MMM] → 
“save” 

 Navigator → acquire at items → mapping → “GO” (1.5 min per point) 
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7. Setup Multishot Record  

Take search image on square with visible Quantifoil holes 

 On the Navigator panel Add 5 points in dice pattern as shown. 

  

Take view of center point.  I f point is away from center hole (# 8 as shown), place 
marker in center of hole, navigator → shift to marker → “OK” 

Move stage to the center point.   

Navigator panel → “Go to XY” 

Point on carbon before Shift to Marker Point on hole after Shift to Marker 
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Take a view, check that it’s centered (to center left mouse click and drag to move the 
stage over the center of the hole. 

Navigator → montage and grids → Setup Multishot Parameters  

 Click “Four corners of regular pattern” (Multiple Record Setup - Pink Arrow) to begin 

 Navigator 

  Select 1st point (#9 as shown -- Blue) in multishot → IS to XY (Green Arrow). 

  Take view. 

  If not centered, right click and drag to center. 

  Save Image shift (Multiple Record Setup). 

 Navigator. 

  Select 2nd point (# 10 as shown)→ IS to XY. 

  Take view. 

  If not centered, right click and drag to center. 

  Save Image shift (Multiple Record Setup). 

 Navigator. 

  Select 3rd point (#11 as shown) → IS to XY 

  Take view 

  If not centered, right click and drag to center 
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  Save Image shift (Multiple Record Setup) 

Navigator 

  Select 4th point (#12) → IS to XY 

  Take view 

  If not centered, right click and drag to center 

  Save Image shift 

 Take Search and View image to check pattern over holes 

 Multishot Record → Change to 7 by 7 (or 5 by 5) 

 

8. Set position of Focus beam  
In Low Dose Panel, Define position of area focus → on View image left click on carbon 
film between Quantifoil holes so the yellow circle in over the carbon.   
Set “Position on tilt axis” for R1.2/1.3 that is normally -1.8 or 1.8 microns. 

Then click None on the Low Dose Panel to switch back. 

At this point Focus beam is over the carbon and not illumining the hole. 
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9. Check Focus beam so it does not overexpose sample 

In Low Dose panel, go to View to move the stage over a hole in SerialEM by taking images or 
using the microscope control panels.  To do this follow these instructions…. 

On the Microscope 

 Insert Flue Cam. 

 Make sure it is centered over the hole if not adjust the stage XY position. 

On SerialEM. 

 In Low Dose Panel, Select Focus, and click additional beam shift check. 

On Microscope Flue Screen. 

 Adjust position of the beam using the XY multifunction knobs so the beam is 
centered. 

On SerialEM. 

In Low Dose panel, uncheck additional beam shift. 

At this point you have confirmed that Focus beam is over the carbon and not illumining 
the hole. 

10. Check Offset to View and Search so Record, View and Search are over the same 

area. 
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When aligned the Record or Preview, View and Search will look like this (above) 

On the Navigator (or using the FlueCam) add point or marker on an ice crystal go to XY (as 
shown above). 

Go to Record, search for ice, use Flu Cam on microscope computer, move stage to the ice, 
take a Preview or Record…..if the image are not over the same area set offset for View and 
Search in the Low-dose pane. 

 

To do this…. 

Select offsets for View (Green arrow), take View image. 

Uncheck move stage for big mouse shifts (Purple arrow). 

Right click and drag to correct place on ice → “set” in lose dose control (Blue arrow) 

Re-check move stage for big mouse shifts (Purple arrow). 

Select offsets for Search, take Search image (Green arrow). 

Uncheck move stage for big mouse shifts (Purple arrow). 

Right click and drag over ice → “set” in Low Dose panel (Blue arrow). 
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Re-check move stage for big mouse shifts (Purple arrow). 

 

Take a Search, View and Preview image, the ice should be in the center of each image. 

At this point the Search, View and Record are over the same area of the sample 
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11. Copy image of handsome Quantifoil hole to buffer P 
 
Go to a Quantifoil hole that has no ice contamination. 
Take a View Image of it.  
Crop image in Camera parameter if needed.  
Process → reduce image (factor 3)→ “ok” 
Copy to buffer P (Buffer Control). 
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12. Find-holes on each Grid Square Map. 

Double click on a Grid Square (MMM) map in navigator panel 
to open it. 

Add points to the map using the hole finder. 

Navigator → Montage and Grids → Find holes in regular grid. 

Adjust hole size and periodicity as needed (Orange arrow).   

To measure holes size Shift + Left mouse click, drag to draw line over 
holes.  look at log file for values. 

Click “Find holes” (Green arrow). 

Adjust sliders in the Hole Finder so the acquire points turn (pink) and 
exclude holes (Blue or cyan, as shown). 
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Click “Make navigator point” (Hole Finder – previous page) 

 

Navigator → montage and Grids → combine points for multishot 

  

Click “Combine Points”  

Do this for each MMM Map. 

At this point each of the Grid Square Maps (that are good) have Acquire Points over the 
holes for data collection. 
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13.  Setup data collection 

Open and edit data collection script, normally don't need to change anything.  The defocus 
range might need to be adjusted from experiment to experiment. 

Normally set …… 

 Touch = 0 {to move the beam away from the center of the hole} 
 Fixobj = 0 { to correct Obj Astigmatism} 
 TD_low = 0 to - 0.5 
 TD_high = -0.5 to -1.5 

 “Script” → “Edit” → “4” (“Script4: DataCollection_V6”) 

 

Adjust “Script5” (Multishot Threshold) change the “numMultishot” value.  As an 
example for a 7x7 multishot set to 25, for 5x5 multishot set to 20.   

 

Camera → Parameters → record 

 As shown in the image….. 

Check save frames. 

Uncheck align frames. 

Set File options → update basename to date → OK 

Set folder → navigate to (X:K3Data\ [new session file: date_initals] 
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Make folder [Data]  navigate to [Data] → OK 

 

Navigator → acquire at items → final data → run script “DataCollection_V6”, run 
script before action Multishot_Filter_Threshold → GO (couple hours) 

As shown in this image. 
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At this point data is being collected, make sure to check the Gatan K3 computer. 
 

14. Run CryoSPARC Live to assess data quality. 

Typically, the MaxCTF fit is < 5 Å 

Defocus range 5000 – 20000 Å 

Total motion < 50 pixels 

Astigmatism is 0-600 Å 

Particle are visible and embedded in thin ice. 

If the data quality is poor check the microscope, data collection parameters, serialEM 
setup.   

 
15. If you are collecting data O/N or over weekend Run Argus2.py on workstation #2.   

On WKS1 open the command terminal  

CD to home directory (/home/cryosparc_user) 

 $ cd ~ 

Now run argus.2 and enter the directory where the data is  

$ python3 ./argus2.py   
Enter /directory/to/monitor : /mnt/k3data/20250603_JDS/Data  
Do you wish to send additional notifications? Enter (y/n): n  
Skipping additional notifications.  
Argus is now monitoring /mnt/k3data/20250603_JDS/Data  
 

If you type Y, You can add your cell phone or email to get a notification once data 
collection stops.   
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16. Monitor the data collection for 15-30 mins to make sure there are no errors on the 
microscope side.  If you are collecting data O/N please make sure the data quality is 
good, argus2 is running, and that there are no errors on the microscope or camera.   

The 2D Classes averages should have some ultrastructure, shape or elements of 2nd 
structure.  Depending on the sample wait until 100-200 movies have been collected or 
~5,000 particles in the class averages.   

Before you leave the core check… 

1. LN2 tanks on the microscope. 
2. No errors on the microscope, serialEM, or workstation. 
3. Walk in the microscope room make sure nothing is out of place or missing. 
4. Check the Gatan K3 computer make sure is has enough disk space. 


